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Aim and Learning Outcomes

Module Aim: To equip students with basic understanding of 
3D Printing

Number of Hours: 4 hours

Learning outcomes: • Knowledge on 3D Printing approach and 
basic terminology

• Understanding the advantages and 
limitations of 3D Printing for different 
applications

• Knowledge on the process steps for 
obtaining an object using 3D Printing 
technology 
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Lecture Outline

• Additive Manufacturing approach
• 3D Printing advantages and limitations
• History of 3D Printing
• 3D Printing technology steps
• 3D Printing applications fields
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Additive Manufacturing 
approach
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3D Printing or additive manufacturing is 
a process of making three dimensional 
solid objects adding material layer by 
layer. Physical objects are produced by 
using digital model data from 3D model 
or other data source, like AMF* file. 
By using 3D Printing it is possible to 
produce objects of almost any shape 
and form.
Curently many different 3D printing 
technologies and materials are used. 
Recently 3D printing tools are available 
for industrial manufacturing and for 
home users as well.

Additive Manufacturing approach

Source: www.smartfactory.lt

*AMF – Additive Manufacturing File
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What is 3D 
Printing and 
How Does It 
Work?

Additive Manufacturing approach

https://www.youtube.com/watch?v=Vx0Z6LplaMU
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3D Printing advantages 
and limitations
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Complexity and freedom of design

• 3D printing lets create complex
shapes and parts – many of which
cannot be produced by
conventional manufacturing
methods.

• Complex geometries can be
created easily and it allows a large
amount of design freedom.

• By using 3D Printing complex
models can be produced as a
single piece on the spot,
therefore there is no need to
produce smaller parts and
assemble them.

3DP advantages

3D printed lamp
Source: http://mymodernmet.com/bathsheba-grossman-3d-printed-lamps/
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Customization and personalization
• 3D printing allows for easy

customization. Each and every
item can be customized without
additional manufacturing costs.

• If there is a need to change a
design of particular item, the
digital design has to be changed
only with no expensive
manufacturing process or
additional tooling.

3DP advantages

OwnPhones – customized earphones
Source:  https://www.kickstarter.com/projects/ownphones/ownphones-
the-worlds-first-custom-fit-3d-printed-e
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No need for tools
• One of the advantages of 3D printing compared to

traditional manufacturing is that the 3D printing
process generally doesn’t require any special new
tooling to produce model or it’s parts.

• No additional costs or lead times are required
between making an object complex or simple.

3DP advantages
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Speed and costs savings
• One of the main advantages of 3D Printing is the

speed of production comparing to traditional
manufacturing methods. Complex models can be
printed in a relatively short time.

• Lowering costs is also achieved by saving time. For
example objects or their parts could be produced
much quicker and as they are needed, therefore the
costs of inventory storage and labor time could be
reduced.

3DP advantages
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Faster and less risky route to market
• As models or their parts can be produced in a short

time, 3D Printing is used for rapid verification and
development of design ideas. It is cheaper to
produce a 3D prototype, then to redesign an existing,
if there is a need.

• Therefore, 3D printing is good choice for those, who
are looking into manufacturing a product idea,
because there is much less risky route to the market.

• 3D Printing can also reduce risk of danger associated
with some manual prototyping processes.

3DP advantages
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Less waste, sustainable, environmentally friendly
• 3D printing is an additive process - an object is

created from the raw material layer by layer. Additive
manufacturing methods generally only use the
amount of material needed to create that particular
object.

• Most processes use materials that can be recycled or
can be reused for more than one build resulting in
additive manufacturing process producing very little
waste.

3DP advantages
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• Higher cost for large production runs
• The price of printers and raw materials are still expensive but

in near future these expenses tend to decrease
• Less material choices, colours, finishes

• There are still some limitations compared to conventional
product materials, colors and finishes

• Limited strength and endurance
• Not all printing technologies can ensure strength of produced

objects, and the strength is not uniform due the layer-by-layer
fabrication process

• Accuracy of printed objects
• If there is a need to print precise parts or finer details – it is still

difficult to ensure the high precision capabilities of certain
manufacturing processes

• Majority of 3D printers are limited by scale and size

3DP limitations
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3D Printing challenges
Despite limitations that
we have today, 3D
Printing technologies are
developing very fast and
expenses of 3D Printing
tend to reduce, therefore
use of this technology
becomes more and more
widespread.
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Short history of 3D 
Printing 



This project has been funded with support from the European Commission. This material reflects the views only of the 
author, and the National Agency and European Commission cannot be held responsible for any use which may be made 
of the information contained therein.

2016-1-RO01-KA202-024578

In 1983 Chuck Hull, co-founder of
3D systems, invented the first 3D
printing process and called it
‘stereolithography’ (SLA).
In a patent, he defined
stereolithography as ‘a method
and apparatus for making solid
objects by successively “printing”
thin layers of the ultraviolet
curable material one on top of
the other’.
With this, he built the foundation
of what we today know as
additive manufacturing (AM) – or
3D printing.

Short history of 3D Printing

The SLA-1, the first commercially available 3D printer
Source: https://www.3dsystems.com
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The first Selective 
Laser Sintering (SLS) 
printer was 
developed and 
patented by Dr. Carl 
Deckard and Dr. Joe 
Beaman at the 
University of Texas 
in 1986.

Short history of 3D Printing

American Newspaper, 1987
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The first 3D printed part

Source: https://www.3dsystems.com/
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In 1989, S. Scott Crump with his wife and Stratasys co-founder
Lisa Crump invented and filed a patented ‘Fused Deposition
Modeling’ technology (FDM).
FDM is trademarked by Stratasys - as such, many industry
professionals choose to use FFF (Fused Filament Fabrication)
instead.

Short history of 3DP
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By 2005, additive technology
patents were starting to
expire.
In 2004 RepRap project was
launched at the University of
Bath (England) by a senior
lecturer in mechanical
engineering dr. Adrian Bowyer.
The project aim was to create
a low-cost 3D printer capable
of replicating itself.
On 9 February 2008, RepRap
1.0 "Darwin" successfully 3D
printed over 18% of its own
components.

Short history of 3DP

Source: https://all3dp.com/history-of-the-reprap-project/
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Advent of compact, open source,
free-software printers like the
RepRap helped to bring the
technology to a wide group of
users and allowed for small-scale
commercial, educational, and
domestic use, and low-cost 3D
printing companies started to
emerge.
The first desktop 3D printer was
born through the RepRap
project.

Short history of 3DP

Source: www.reprap.org
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3D printing was mostly limited to industrial uses until 2009.
3D printer sales have been growing ever since.
It is expected many more innovations in the years to come.

Short history of 3DP
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Carbon3D, 
one of the 
fastest 3D 
printing 
technologies 
currently 
under 
development

Short history of 3DP

https://www.youtube.com/watch?v=UpH1zhUQY0c
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Short history of 3DP

https://www.youtube.com/watch?v=OjaW6C61_dc

Chuck Hull / 3D 
Printing 
Inventor
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3D Printing technology 
steps
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1. CAD
The first step in the additive manufacturing process is
producing a digital model. For this purpose Computer Aided
Design (CAD) modeling is used.
There are many CAD programs that use different modeling
principles, capabilities and pricing policy. For example
Solidworks, Autodesk Fusion 360, SketchUp could be used.
Reverse engineering can also be used to generate a digital
model via 3D scanning.

3DP technology steps
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2. Model in STL format
In this step of additive manufacturing (AM) process a CAD
model is converted into a STL (stereolithography) file that is
acceptable by AM Machines.

It is also possible to select a STL model from online repositories
like Pinshape, GrabCAD etc. Some of these repositories offer
models for free, some are charged.

3DP technology steps
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3DP technology steps
3. STL model analysis and repair
In this step it is required to repair any errors within the STL file.
Typical errors could be like missing triangles, non connected edges
or inverted normals where the “wrong side” of a triangle facet is
identified as the interior of the part.
There are software for STL model manipulations, for example
Meshlab, 3DPrintCloud, Netfabb etc.
If there are no errors, then some object corrections like sizing,
density, geometry changes could be made.
A proper orientation of the 3D model also could be set up.
Once a STL file has been generated it is imported into a slicer
program which converts it into G-code. G-code is a numerical
control (NC) programming language, used in computer-aided
manufacturing (CAM) to control automated machine tools like 3D
printers.
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4. Setting up device
In this step device should be prepared for printing. This process
requires proper printer setup and control, cleaning from
previous build and loading print material. A routine check of all
critical build settings and process controls is also necessary.
When hardware is ready, build file could be uploaded to the 
machine.

3DP technology steps
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5. Printing
The whole printing procedure is mainly automatic. Depending
on the size of a thing, machine and materials employed, the
procedure might take several hours or even days. There is a
need to check occasionally if there are no errors.

3DP technology steps
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6. Removal of prints
In most cases of non industrial 3D Printing removal of the
finished print is a simple task: separating the printed part from
the print bed.

3DP technology steps
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7. Post processing
Post processing may vary greatly depending on printing
technology and materials used. For example a print made with
SLA must be cured under UV, while print made with FDM can
be handled right away.
Post processing the final product may include high pressure air
cleaning, polishing, colouring and other actions to prepare for
final use.

3DP technology steps
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3D Printing application 
fields



This project has been funded with support from the European Commission. This material reflects the views only of the 
author, and the National Agency and European Commission cannot be held responsible for any use which may be made 
of the information contained therein.

2016-1-RO01-KA202-024578

3D printing in the
automotive industry is
used to both prototypes
and finished parts.
Many Formula 1 racing
teams have been using
3D printing for
prototyping, testing and
ultimately, creating
custom car parts that
are used in competitive
races.

Automotive industry

Racing car seat
Source: www.voxeljet.com
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Automotive industry

Rebuildable car tire
Source: https://futurism.com/videos/meet-the-tire-that-never-needs-air-or-be-
replaced/

This Michelin concept tire 
doesn‘t need air because it is 
3D printed and would never 
need replacing.
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One of the most important
applications of 3D printing
is in the medical industry.
With 3D printing, surgeons
can produce patient-
specific 3D printed models
of patients' body parts or
organs. They can use these
models to plan and practice
surgeries, potentially saving
lives.

Medical industry

The first 3D printed polymer implant to receive FDA approval
Source: http://3dprintingindustry.com/news/the-first-3d-printed-polymer-implant-to-
receive-fda-approval-5821/
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Prosthesis

3d printed body part
Source: http://weburbanist.com/2015/01/08/exo-prosthetics-light-cheap-custom-3d-printed-body-parts/
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Prosthesis

3D-Printed Prosthesis
Source: http://weburbanist.com/2013/07/18/handicapable-3d-printed-flexible-casts-artificial-limbs/
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Designing 
Confidence 
The innovative 
work of Scott 
Summit 
demonstrates 
how 3D Printing 
and digital 
scanning can be 
used to greatly 
improve 
Prosthetic 
design.

Prosthesis

https://www.youtube.com/watch?v=6wnnNk91EMs
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Dental industry

3D printing for dental industry 
Source: x3dprinting
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Aircraft

Jet Engines with 3D-Printed Parts Power Next-Gen Airbus Passenger Jet
Source: http://www.gereports.com/post/119370423770/jet-engines-with-3d-printed-parts-
power-next-gen/

GE Aviation and Safran 
have developed a method 
to 3D print fuel nozzles 
for jet engines. The 
technology allows 
engineers to replace 
complex assemblies with 
a single part that is lighter 
than previous designs, 
saves weight and boosts a 
jet engine’s fuel efficiency 
by up to 15%. 
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Aerospace

Elon Musk’s commercial space 
company SpaceX used 3D 
printing to manufacture the 
engine chambers for their 
SuperDraco engine that will be 
installed on the company’s 
Dragon spacecraft.
Read more 

A 3-D printed SuperDraco combustion chamber. 
Photo Credit: SpaceX
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Instead of blowing up a priceless 
classic car SkyFall movie makers 
3d printed one-third scale replica 
of Aston Martin DB5s from 
scratch and then in a destructive 
special effects scene blew it up. 
Read more.

Entertainment

Plastic parts of the Aston Martins ©Propshop Modelmakers Ltd

Finished model of the Aston Martins ©Propshop Modelmakers Ltd
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Artists and designers use 3D
Printing technology by creating
various art works. It opens up
entirely new dimensions in
creative design that go beyond
the limits of conventional
technologies.

Art/Design/Sculpture

Designer lamps from 3D printers
Source:  https://www.voxeljet.com/industries/foundries/printed-designer-lamps/
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Art/Design/Sculpture

Designer chair
Source: https://www.voxeljet.com/industries/foundries/designer-furniture/
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Art/Design/Sculpture

Ivan the Gorilla sculptor utilizes new 3-D printing technology
Source: https://www.voxeljet.com/industries/foundries/3d-printing-helps-to-return-a-silverback-gorilla-back-to-life/
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3D printing is widely used in 
architecture field. Architects can 
quickly and easily create 3D 
printed scale model from their 
CAD data that is used for 
developing blueprints. 3D 
printed models can be printed in 
multiple materials and realistic 
colors.

Architecture

Source: https://www.frendel.com/gallery-image/project-absolute-world/
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The beautiful 
Absolute 
Towers in 
Ontario, 
Canada are 
the creation 
of architect 
Attila Burka

Architecture

https://www.youtube.com/watch?v=il5H-9oKBVo
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Jewelry

3 D Printing may open up the art of 
creating jewelry to a wider rage of 
hobbyists as it does not require 
expensive precision tools, steady 
hand and many years of 
experience.

Source: CustomMade
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Although not 
necessary 
economical 3D 
Printing can be used 
in fashion field – for 
making high heels, 
bikinis and handbags 
can be 3-D printed 
instead of sewn. 

Fashion

Source: Shapeways
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World's first 
3D printed 
bikini heads 
for the beach

Fashion

https://www.youtube.com/watch?v=d2iT8S0m3m4
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World's first 
chocolate 3D 
printer

Food

https://www.youtube.com/watch?v=BIFi8but3Vw
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3D printing provides an
excellent method for
geometry visualizations
and design initiatives at
art schools. It is also used
in numerous disciplines
of study for research
purposes.

Education

3D Printer Frog Dissection Kit. 
Source: MakerBot Thingiverse



This project has been funded with support from the European Commission. This material reflects the views only of the 
author, and the National Agency and European Commission cannot be held responsible for any use which may be made 
of the information contained therein.

2016-1-RO01-KA202-024578

Examples how 3D 
Printing could be 
used for everyone

Other fields

Infographics by Jeff Hansen, HoneyPoint3DTM
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Useful Topic Related 
Links

https://en.wikipedia.org/wiki/3D_printing

https://www.youtube.com/watch?v=Vx0Z6Lpl
aMU
https://youtu.be/Tyc4Apyk2Rc

https://www.ted.com/talks/avi_reichental_wh
at_s_next_in_3d_printing
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Available 3D Printing 
Technologies



This project has been funded with support from the European Commission. This material reflects the views only of the 
author, and the National Agency and European Commission cannot be held responsible for any use which may be made of 
the information contained therein.

2016-1-RO01-KA202-024578

Aim and Learning Outcomes

Module Aim: To equip students with basic knowledge on the 
main 3D Printing processes, their advantages 
and limitations, basic understanding on 
materials issues in 3D Printing and with basic 
knowledge on STL file format

Number of Hours: 3hrs

Learning outcomes: • Acquiring knowledge on the main 3D 
Printing processes together with their 
advantages and limitations

• Understanding the basics of materials issues 
in 3D Printing

• Acquiring knowledge on the STL file format
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Lecture Outline

• Types of 3D Printing processes: 
• basic principle
• main characteristics
• materials
• advantages and limitations
• examples 

• STL file format
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Lecture Focus

Lecture focus (1st part)Lecture focus (2nd part)

3D CAD 
Modelling

Type of 3D Printing process

STL file
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Types of 3D Printing 
Processes



This project has been funded with support from the European Commission. This material reflects the views only of the 
author, and the National Agency and European Commission cannot be held responsible for any use which may be made of 
the information contained therein.

2016-1-RO01-KA202-024578

Other….

E.g. Laminated Object 
Manufacturing (LOM):

Raw material:

Paper

Can be classified according to the state of the raw material which 
is utilised
Two types of processes are considered, as these are the most 
commonly used:

Types of 3D Printing processes

3D Printing Technology

Fused Deposition 
Modelling (FDM)

Raw material state: 
Polymer filament

Stereo Lithography 
(SL)

Raw material: 
Photosensitive 
Liquid Resin

Selective Laser 
Sintering (SLS)

Raw material:

Powder (including 
polymer, ceramic, 
metal)

Lesson focus
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Basic Principle:
1. A filament of polymer is extruded 

from a nozzle where it is heated 
above its melting point and 
deposited on the table surface

2. When this layer solidifies, the 
nozzle is coordinated according to 
the part geometry at that level

3. The polymer is again extruded 
and when it contacts the previous 
surface, it solidifies to form the 
second layer

4. The procedure is repeated until 
the part is finished

Fused Deposition Modelling (FDM)

Zortrax FDM Printer
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Click on the 
video on the 
right to 
understand 
how FDM 
works

FDM Principle

https://www.youtube.com/watch?v=WHO6G67GJbM
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1. Layer thickness range (mm): 0.127 to 
0.33 (depending on material)

2. Part build envelope (mm): 600 x 500 x 
600 max.

3. Tolerance: ± 0.254mm
4. Built part: fully functional, however, 

weak in the z-direction

FDM – Main Characteristics

N.B.: The above are only indicative 
characteristics as these vary from one 
FDM 3D Printer make and model. This 
applies for other 3DP technologies. Building envelope of the 

Zortrax FDM Printer

z

x
y
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• Typically FDM requires two types of 
material:
1. Build material which constitute 

the desired 3D form geometry
2. Support material which is 

required for 
overhangs/undercuts. The 
support structures are 
automatically generated by the 
software program supporting the 
FDM 3D printer.

FDM – Materials

Support material required for 
the internal thread

Build material constituting the 
desired geometry
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Support material can either be manually 
broken away or removed automatically by 
inserting the 3D physical model into a 
water-based solution

FDM – Materials

Example of an FDM part inserted 
into a water-based solution to 

remove support material 
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• Examples of commonly used build 
material in FDM:
1. ABS - used for functional 

prototypes with good mechanical 
strength & chemical resistance. 
Available in different colours

2. PC - used for functional prototypes 
with a very high impact resistance 
and a thermal deflection at 125ºC

FDM – Materials

Example of an ABS cartridge used 
to build parts in an FDM printer
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• Advantages
1. no use any toxic material, can be 

used in an office
2. simple post-processing is required
3. some FDM 3D printers are very 

cheap and hence very accessible

FDM – Advantages & Limitations

• Limitations
1. part accuracy is dictated by the 

filament thickness
2. parts are weak in the vertical 

direction

Stratasys desktop FDM Printer

Reprap FDM Printer
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• Exemplar physical replicas of 
medical models

FDM – Examples of 3D Printed Parts

• Model of the regions in Lithuania 

• Prototype of a 
shipyard crane 

(Source: University Politehnica of Bucharest)

(Source: Northern Lithuania College)

(Source: Centro Formación Somorrostro)
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Basic Principle:
1. The platform is initially 

positioned near the surface of a 
photosensitive liquid polymer

2. A directed laser beam solidifies 
the polymer

3. When the initial layer is 
completed, the platform is 
lowered and a second layer is 
formed

4. The procedure is repeated until 
the part is finished

Stereolithography(SL)

Formlab2 SL Printer
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Click on the 
video on the 
right to 
understand 
how SL works

SL Principle

https://www.youtube.com/watch?v=NM55ct5KwiI
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1. Layer thickness range (mm): 0.016 –
0.127

2. Part build envelope (mm): 2100 x 
700 x 800 max.

3. Tolerance: ± 0.15mm
4. Built part: fine details, very good 

accuracy and surface finishes

SL – Main Characteristics

Build envelope of the 
Formlab2 SL Printer

x

z

y
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SL – Materials

• In the case of SL, the support 
structures required for 
overhangs/undercuts is made up 
from the same material used for 
building the prototype.

• Support structures are removed 
manually

• SL parts are typically post cured in 
an UV oven

Build material constituting the 
desired geometry

Support structure
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• Build material used in SL is mostly a 
photosensitive resin, meaning that is 
cures when exposed to UV radiation

• Mechanical properties of part depends 
mainly on material type and post-curing 
time

• There are different trade names of 
resins used by specific SL printers (e.g. 
Accura 25 utilised by 3D Systems SL 
printers)

SL – Materials

Example of tough photopolymer 
resin cartridge from Formlabs
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• Advantages
1. SL produces accurate parts with high 

surface finish
2. wide spectrum of photopolymer 

materials is available with different 
characteristics

SL – Advantages & Limitations

• Limitations
1. material must be photosensitive 

and is more expensive compared 
to that used in FDM

2. build process can be slow
Parts produced by the 
Photocentric SL Printer
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Prosthesis hand and company logo 
produced by Formlab2 SL printer

SL – Examples of 3D Printed Parts
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Lecture Outline

• Lecture organisation
Lecture focus (1st part)Lecture focus (2nd part)

3D CAD 
Modelling

Type of 3D Printing process

STL file
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STL File Format
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• STL is the de facto neutral format for 
interfacing CAD and 3DP systems

• Stands for Standard Tessellation 
Language

• STL files are generated through 
tessellation of accurate CAD models

• Surfaces of 3D solid models are 
approximated with triangular facets

• There are two types of STL file formats 
– ASCII and binary. With the latter 
format, STL files are smaller in size

STL File Format
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• Each triangle is defined independently 
by its 3 vertices and a unit normal

STL File Format

X1, Y1, Z1

X2, Y2, Z2

X3, Y3, Z3

Lx, Ly, Lz
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• Two important requirements 
during STL file generation:

1. ordering of vertex labelling
2. observance of vertex-to-

vertex rule

STL File Format




3 1

2

Ext. surface

1 3

2

Int. surface
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• A virtual 3D model can be converted to STL file format in a CAD 
system

STL File Format
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• The tessellated 3D model in STL can be viewed in a free STL file 
viewer software package (e.g. Open3D Model Viewer)

STL File Format

Original 3D CAD model Tessellated 3D model in Open3D 
Model Viewer
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• Such a software allows user to zoom in/out of the tessellated 
3D model, view normal at each face etc.

STL File Format

Normal at each 
triangulated face 

displayed in Open3D 
Model Viewer
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Useful Topic Related Links

What is tessellation? 

Fused Deposition Modelling

Stereolithography 

Preparing STL files for 3D Printing 

Exporting STL files in Fusion 360
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3D Printing equipment
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Aim and Learning Outcomes

Module Aim: To equip students with basic understanding of 
difference between industrial 3D printer, 
desktop 3D printer and home/hobbyist 3D 
printers, basic understanding of the main 
components of a FDM 3D printer

Number of Hours: 2hrs

Learning outcomes: • Understanding difference between industrial 
3D printer, desktop 3D printer and 
home/hobbyist 3D printers

• Understanding the main components of a 
FDM 3D printer
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Lecture Outline

• RepRap project
• Fused Deposition Modelling/Fused Filament 

Fabrication process
• FDM/FFF equipment
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RepRap Project
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RepRap (Replicating Rapid-prototype) is the self-
replicating 3D printer.

At the University of Bath (England) the RepRap
project was started with the aim to develop a
low-cost 3D printer with capability to replicate
itself.

RepRap uses an additive manufacturing
technique called Fused Filament Fabrication (FFF)
to lay down material in layers: a plastic filament
is unwound from a coil, melted and fused to
manufacture a part.

Through the RepRap project’s mission to build a
self-replicating machine, the first desktop 3D
printer was born.

Read more at www.reprap.org

RepRap project

RepRap version 1.0 (Darwin)
Source: https://all3dp.com/history-of-the-reprap-project/
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RepRap project
Currently hundreds of collaborators from entire world
contribute to RepRap project. As RepRap is an open design, all
of the intellectual property produced by the project is
released under a free software license, the GNU General
Public License.

• How to build a reprap 3D printer - RepRapOneDarwin (1st 
generation)

• How to build a reprap 3D printer - Huxley (mini-reprap, 
portable)

• How to build a reprap 3D printer - Mendel (RepRap Version 
II)

• How to build a reprap 3D printer - Prusa (easy to assemble)
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RepRap project

https://www.youtube.com/watch?v=FUB1WgiAFHg

RepRap Open 
Source 3D Printer
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Timelapse of 
Adrian 
assembling 
the first 
RepRap 
“Darwin”

RepRap project

https://www.youtube.com/watch?v=Mo5Hp_6uD-E
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FDM / FFF process
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FDM (Fused Deposition Modelling) is most widely used and
affordable technology in 3D Printing.
FDM is also sometimes refereed to FFF (Fused Filament
Fabrication) since FDM is a proprietary term that can only be
used by Stratasys Inc. The RepRap project coined FFF so that the
technique could be used without trademark infringement.

FDM/FFF process
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Basic Principle
Using Fused Deposition
Modeling (FDM) filament of
plastic material is heated and
extruded through an extrusion
head. Then molten plastic is
deposited in X and Y coordinates
layer by layer, while the build
table lowers the object in the Z
direction.
This way building of the object is
done from the bottom up.
For elaborate objects some
support structures acting as
scaffolding are printed which are
removed after the printing is
finished.

FDM/FFF process

Schematic of FDM technology

Printing bed

Surface

Extruder

Extrusion
Nozzles

Support 
Material 
Spot

Build
Material 
Spot
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FDM/FFF process

https://www.youtube.com/watch?v=WHO6G67GJbM

Fused Deposition 
Modeling (FDM) 
Technology
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FDM equipment
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Home/hobbyists FDM 3D Printers

Home/hobbyist 3D Printers
– low cost, but there is a
need of ‘do-it yourself’
skills and some technical
knowledge.
They are mainly used for
creating customized items,
toys, decorative objects
and such.

Source: http://www.independent.co.uk/life-style/gadgets-and-tech/features/q-how-hard-can-3d-printing-
really-be-a-quite-hard-8761809.html



This project has been funded with support from the European Commission. This material reflects the views only of the 
author, and the National Agency and European Commission cannot be held responsible for any use which may be made of 
the information contained therein.

2016-1-RO01-KA202-024578

For 3D printing right from user’s desk desktop FDM
machines are used. These machines are easy to use,
have software with user-friendly and intuitive
interface and can produce parts quickly and in a cost-
effective way. Users can create objects’ designs by
themselves or find them on the online repositories
and customize them according to their need.

A special group of desktop 3D printers are
professional printers. They are used for concept
modelling, producing functional prototypes or even
end-use parts. These printers are more powerful and
more expensive than consumer grade desktop
printers.

Desktop 3D printers can be used in small business,
education sectors and other.

Desktop FDM 3D Printers 
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Industrial 3D Printers are used to produce fully functioning high quality products, achieve large build volume and
requires some special conditions like large working space, appropriate power supply and others.

Industrial printers are large, sometimes even need to be installed right in the building, have high printing resolution
and use quality materials, mainly engineering plastics which can have special properties like high impact strength,
chemical resistance, thermal stability.

The major differences of desktop and industrial printers are associated costs and production capabilities – industrial
printers can produce larger parts in one print and complete order of the same size faster.

Industrial FDM 3D Printers

Source:  Stratasys
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Industrial FDM vs. Desktop FDM

Property Industrial FDM Desktop FDM

Standard accuracy ± 0.15% (lower limit ± 0.2 
mm)

± 1% (lower limit: ± 1.0 
mm)

Typical layer thickness 0.18 - 0.5 mm 0.10 - 0.25 mm

Minimum wall thickness 1 mm 0.8 - 1 mm

Maximum build envelope Large (e.g. 900 x 600 x 
900 mm)

Medium (e.g. 200 x 200 x 
200 mm)/td> 

Common materials ABS, PC, ULTEM PLA, ABS, PETG

Support material Water-soluble Same as part (typically)

Production capabilities 
(per machine) Low/Medium Low

Cost $50000+ $500 - $5000

Source: https://www.3dhubs.com/
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Main components of FDM 3D printer
Print bed
Typical print bed (the surface
that objects are printed on
to) is a sheet of glass with
some kind of surface on top
for helping the plastic stick.
Most printers have heating
element for heating the bed.
This is needed to prevent the
object from warping and
peeling off the bed during
printing process.
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Main components of FDM 3D printer

Bed surfaces
The bed surface helps the plastic stick to the bed
during printing but also allows it to be removed
easily when printing is done. There are many
different kinds of bed surfaces. Most printers will
come with some kind of all purpose surface,
however, for best results it is better to use different
surfaces depending on the printing material.
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Filament
In FDM printers a thin
filament of thermoplastics
(plastics that melt when
heated and solidify at room
temperature) is used.

Main components of FDM 3D printer
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Extruder
The essential part of 3D printer is 
the extruder. It has two parts: 
cold end with motor, which 
draws the filament in and pushes 
it through, and hot end where 
the filament is melted and 
squirted out.

Main components of FDM 3D printer
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Head movement mechanics
The most common 3D printers on the
market are Cartesian printers, named
after cartesian coordinate system. Such
printers have rectangular frame wherein
any movement can happen along one of
three perpendicular axes: X, Y or Z.
Typically print bed moves in the Z-axis,
while the extruder can move in four
directions along X and Y-axis.

In Delta 3D printers, the extruder is held
by three arms in a triangular
configuration (thus the name “Delta”).
The print bed is usually circular and does
not move. Print-head position is
estimated using trigonometry. Delta
printers are faster than Cartesian and
because of their design can print
relatively tall objects, but may be less
accurate than Cartesian printers.

Main components of FDM 3D printer
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Head movement mechanics
Polar 3D printers use polar coordinate system, where positioning is
determined by an angle and a length, rather than coordinates X, Y and Z.
This means, that the bed rotates in a circle, while the print-head moves up,
down, left and right. Polar printers can function with only two stepper
motors and can make larger objects while using less space.

The fourth category, which is beginning to see an increase in use, is 3D
printing using Robotic Arm with advantages like mobility, flexibility in
printer head positioning and printing process which is not fixed to a
printing plate. However, the print quality is not as good as conventional
Cartesian printers.

Main components of FDM 3D printer
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Main components of FDM 3D printer

Example of Cartesian 3D printer –
LulzBot Mini 3D Printer

Example of Delta 3D Printer –
SeeMeCNC Rostock MAX v3 3D Printer 
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Main components of FDM 3D printer

Stepper Motors
In 3D printers for precise position control stepper
motors are used, which, when given power, rotate in
increments rather than continuously.
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The Frame
Frame holds all other parts of 3D printer together. It 
can be made of sheet metal, aluminium or plastic. 
Often many frame parts can be 3D printed 
themselves.

Main components of FDM 3D printer
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Main components of FDM 3D printer
Electrical components
• Power Supply – converts the 120V AC electricity from the 

wall to low voltage DC power for the printer.
• Motherboard - orchestrates execution of commands in the 

form of G-Code given to it by the computer.
• Stepper Drivers - run the stepper motors by firing the coils 

of the motors in sequence, causing it to move in increments. 
• User interface – some printers may have a LCD screen which 

allows to control them directly without the need of 
computer. 

• SD Card Slot – some printers also have an SD card slot from 
which they can load G-Code files.
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Useful Topic Related Links

https://en.wikipedia.org/wiki/Fused_filame
nt_fabrication

https://www.youtube.com/watch?v=f4RGU
2jXQiE

https://vimeo.com/5202148
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3D CAD modelling software 
applications



This project has been funded with support from the European Commission. This material reflects the views only of the 
author, and the National Agency and European Commission cannot be held responsible for any use which may be made of 
the information contained therein.

2016-1-RO01-KA202-024578

Aim and Learning Outcomes

Module Aim: To equip students with basic understanding of 
3D CAD modelling principles and with basic 
knowledge on CAD freeware

Number of Hours: 2hrs

Learning outcomes: • Understanding the basics of 3D CAD 
modelling

• Acquiring knowledge on different free 3D 
CAD applications
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Lecture Outline

• What is CAD Technology?
• 2D Modelling
• 3D Modelling
• Benefits of CAD 
• Free 3D CAD applications
• A360 Fusion – A general overview 
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What is CAD 
Technology?
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Computer-aided design (CAD) 
is the use of computer 
technology to aid in the 
design and in the  generation 
of two-dimensional (2D) 
drawings and three-
dimensional (3D) models of a 
component or product

What is CAD Technology?

E.g. a 2D cross-section which 
is revolved about an axis to 
produce a 3D model
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CAD technology has 
nowadays become part and 
parcel of a design activity in a 
range of sectors including:

• architecture
• product design
• jewellery design
• interior design
• medical etc.

What is CAD Technology?
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Link of 3D CAD to 3D-Printing

3D CAD 
Modelling

3D Printing

A 3D CAD model is first created using a free/commercial CAD 
package
The CAD model is then prepared for 3D printing (e.g. converting it 
to STL, removing any errors, setting up layer thickness etc.)
The 3D printing process follows 

Lecture focus:
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2D Modelling
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CAD can be used to create 2D 
shapes in, say, the XY plane 
using simple drawing entities 
(e.g. lines, arcs and circles)
2D shapes can be modified 
by applying basic modify 
commands such as mirror, 
etc.
Such 2D shapes can be used 
as a basis to generate 3D 
models => 2D modelling is 
required for 3D modelling

2D Modelling
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3D Modelling
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There are three main types of 
3D models:

• Wireframe (made up of 
vertices and edges)

• Surface (represent the 
boundary of the object, 
not its volume –
analogy: thin eggshell). 

• Solid (represent the 
volume of the object)

3D Modelling



This project has been funded with support from the European Commission. This material reflects the views only of the 
author, and the National Agency and European Commission cannot be held responsible for any use which may be made of 
the information contained therein.

2016-1-RO01-KA202-024578

Many 3D geometries have a common 2D 
cross-section on which a 3D operation 
has been applied
How we can convert 2D shapes into 3D 
entities?  We have already seen how we 
can transform a simple 2D polyline to a 
3D entity
Basic 3D modelling commands (e.g. 
extrude, sweep, loft), which are 
commonly found in commercial CAD 
packages, allow use to create a wide 
range of 3D models

3D Modelling
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We can also create cross-
sections through a 3D CAD 
model in order to 
illustrate/visualize hidden 
features

3D Modelling
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Benefits of CAD
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A CAD virtual model can be rendered statically 
to reflect how an artefact (e.g. product, 
building etc.) will realistically look like…

Benefits of CAD
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…this will help clients to visualise better  different colour 
schemes, room configurations etc.

Benefits of CAD
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CAD virtual 
models can 
be rendered 
dynamically 
to mimic, for 
instance, the 
function 
physical 
artefacts 

Benefits of CAD

https://youtu.be/a2pJfuDeZdo
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Free 3D CAD applications
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A number of free CAD 
modelling software packages 
are available, such as:

• Trimble SketchUp
• TinkerCAD
• A360 Fusion

Free CAD applications
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Allows users to easily create 3D virtual 
models through a number of straight-forward 
functions, such as Push/Pull and much 
more...

Free CAD applications – SketchUp
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Allows users to easily create 3D virtual models 
on-line, via a simple web-browser

Free CAD applications – TinkerCAD
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Allows users to easily upload and share 3D virtual models 
and drawings on-line, through a web-browser 

Free CAD applications – A360 Fusion
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A360 Fusion – A general 
overview
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One can view the CAD model 
from different angles using 
the orbit tool

A360 Fusion – Viewing Features 
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Click on the 
video on the 
right to play

What is Autodesk Fusion 360?

https://www.youtube.com/watch?v=h9wpIYhYvh4
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Useful Topic Related Links

Computer-Aided Design 

What is Autodesk FUSION 360? 

Fusion 360 for Beginners Webinar
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3D CAD modelling using 
Autodesk Fusion 360
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Aim and Learning Outcomes

Module Aim: To equip students with the basic knowledge 
needed to produce their own 3D printing 
models with Autodesk Fusion 360 software

Number of Hours: 11 hrs

Learning outcomes: • Knowledge on modelling a 3D object from 
scratch using Fusion 360 software

• Knowledge on how to generate STL files 
from Fusion 360 software
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Lecture Outline

• Prologue
• Getting started
• Create 2D sketches
• 3D modelling
• Use materials to control the appearance
• Save model as STL file
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Prologue
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Chapter Outline

Prologue
• Introduction
• Learning Objectives
• Course program
• What is Fusion 360?
• About this study material 
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The aim of this Fusion 360 study material is to provide
participants a brief overview of the software opportunities
and to equip them with basic knowledge about using this
program.
Fusion 360 software is a very comprehensive product
development system and it’s impossible to considered all its
features here in detail. Also, we are considering only the creation
of models for 3D printing. Thus, this material focuses on some
fundamental skills and preparation concepts, after the
acquisition of which the students can independently develop
their skills further.
This material should be taken as a simplified Fusion 360 tutorial
but not as a substitute of the software documentation.

Introduction
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This material consists of six chapters. Themes are logically
connected and its recommended to acquire them in the
presented order. To improve acquisition of this material, some
key issues are related to the practical exercises.
All subsequent material is prepared on the basis of a real product
(a desk organizer) designed to be 3D printed.
In the course you will learn about tools and techniques of Fusion
360 useful for 3D printing models preparation, going step-by-step
through the details of desk organizer modeling.

Learning objectives
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• 3D printable desk organizer

The product to be designed
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Course program
Getting started 
• Download and opening the 

program
• Fusion 360 Interface 
• Basic settings 
• Import and open files
• Entering the command 
• Navigation and selection tools

Create 2D sketches
• Planning a sketch
• Create a 2D sketch
• Constrain and dimension a sketch

3D Modelling
• 3D modelling tools
• Create 3D models
• Edit existing features

Use materials to control 
the appearance
• Apply and edit materials
• Modify appearance

Export models as STL file
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What is Fusion 360? 

Fusion 360 is a cloud-based tool for product development that
integrates CAD, CAM and CAE software, created by Autodesk
Corporation.
Fusion 360 has many features:
• freeform sculpting and modelling
• solid/parametric/mesh modelling
• simulation and testing
• data translation
• assembly modelling
• machining
• 3d printing and many more.
It is an excellent choice for creating models for 3D printing.
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About this study material

Since this course material's screenshots and menu steps are 
taken from a computer with June 2017 version of Fusion 360, 
the future versions of Fusion 360 may cause differences from 
this material (both – in screenshots and menu steps).
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Getting started
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Chapter Outline

Getting started
• Download and opening the program
• Fusion 360 Interface 
• Basic settings 
• Import and open files
• Entering the command 
• Navigation and selection tools
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Learning objectives of this chapter

In this chapter you will learn how to get started with Fusion 
360. 
After completing this chapter, you'll know how to:

• download and open Fusion 360
• use Fusion 360 user interface 
• set basic settings
• open and import Fusion 360 files 
• do command entering 
• use model navigation and selection tools
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To download and use Fusion 360, you will need an Autodesk ID. 
As a student or educator ou can obtain an Autodesk ID and 
Fusion 360 at www.autodesk.com/education/free-
software/fusion-360

Download Fusion 360
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To download and use Fusion 360, you will need an Autodesk ID. 
As a stude hobbyists or enthusiasts you can obtain an Autodesk 
ID and Fusion 360 at www.autodesk.com/products/fusion-
360/free-trial

Download Fusion 360
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The design files that you create in Fusion 360 are saved to
the cloud-based Autodesk 360 (A360) platform in a Project
folder. Thus, you can access your design files from any web
browser or computer with Fusion 360 installed by logging in
with your Autodesk ID.
• Start Fusion 360.
• If required, sign in using your Autodesk ID.

Start Fusion 360
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Fusion 360 Interface 
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• Application bar - Access the Data Panel, file operations, save,
undo and redo

• Profile and help - control profile and account settings; help 
and learning

• Toolbar - select the workspace and the tool
• ViewCube - orbit the design or view it from standard view 

positions
• Browser - lists objects in your design. Can be used to make 

changes to objects and control their visibility.

Fusion 360 Interface 
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• Canvas and marking menu - Left click to select objects in the 
canvas. Right-click to access the marking menu (it contains 
frequently used commands in the wheel and all commands in 
the overflow menu).

• Timeline - lists operations performed on your design. Right-
click operations in the timeline to make changes. Drag 
operations to change the order they are calculated.

• Navigation bar and display settings - The navigation bar 
contains commands used to zoom, pan, and orbit your 
design. The display settings control the appearance of the 
interface and how designs are displayed in canvas.

Fusion 360 Interface 
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In the User Profile drop-down menu located in the top right 
corner, click “Preferences”. Here you can set your preferences 
regarding UI behavior, Units, Visibility, Material, Graphics, etc.

Basic settings
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Fusion 360 has 7 different workspaces, each of them displaying a 
toolbar with tools relevant to that specific workspace. To select a 
workspace, click Model.

Select workspace
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Model: create and edit solid geometry
Patch: create and edit surface geometry
Render: generate realistic renderings of the design
Animation: create animations of how the design should 
work
Simulation: perform stress analysis 
CAM: generate tool-path strategies for the design to 
get fabricated
Drawing: create 2D drawings of a model

Available workspaces
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The display settings bar is located at the bottom of the screen 
and control the appearance of the interface and how designs are 
displayed in canvas.

Display settings
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Import and open a file
In this section you`ll learn how to import and open files.

After completing this section, you‘ll be able to:
• Import files using Cloud Translators
• Import files using Local Translators
• Insert files and components
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Import and open a file
There are several ways to open, import or translate a file in
Fusion 360. To import a file is to upload it to the cloud. Once
it’s imported, the file may be opened in Fusion 360 through the
Data Panel.
If the Data Panel is not shown in the Fusion 360 window, click
the icon within the red square below.
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Use the Upload command (you have to be inside of a project) to 
import a file into Fusion 360. Several file types can be imported 
into Fusion 360, including IGES, OBJ, STEP, STL.

Import files using Cloud Translators
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Use the "New Design from File" command to import Autodesk
Fusion 360 Archive Files, IGES, SAT/SMT Files and STEP Files

Import files using Local Translators
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Use the various Insert command to import components and files 
(OBJ, STL, DXF and SVG).

Insert files and components



This project has been funded with support from the European Commission. This material reflects the views only of the 
author, and the National Agency and European Commission cannot be held responsible for any use which may be made of 
the information contained therein.

2016-1-RO01-KA202-024578

Entering the command

Workflow in Fusion 360 is intended to be flexible for user 
preferences. The commands can be entered by using:
• command icons from Toolbar
• right-click on objects listed on Browser
• right-click on canvas
• keyboard shortcuts
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Navigation tools

There are multiple ways to manipulate the view of your design:
• Navigation Bar
• ViewCube
• Mouse navigation
• Touch gestures for touchpad and touch screen devices
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Navigation commands
The navigation commands are started by clicking on an icon 
from Navigation Bar.

Orbit - commands that rotate 
the current view.
Look At - views faces of a 
model from a selected plane.
Pan - moves the view parallel 
to the screen.
Zoom - increases or decreases 
the magnification of the 
current view.
Fit - positions the entire model 
on the screen.
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ViewCube
• Use the ViewCube to rotate the camera
• Drag the ViewCube to perform a free orbit
• Click faces and corners of the cube to access standard

orthographic and isometric views.
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Mouse
Use mouse shortcuts to zoom in/out, pan the view and orbit
the view. Set the Default Mouse Control in Preferences to
change how you pan, zoom, and orbit with the mouse.
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There are many ways to select objects in Fusion 360.

Selection tools

The icon at the top of the pull down indicates which selection 
mode is active.
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• Window Selection Drag to draw a 
rectangle to select objects.

Selection mode

• Freeform Form Selection Drag 
to draw a lasso to select objects.

• Paint Selection Drag to select 
objects the cursor touches.
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There are many ways tools and filters that can be used:

Selection tools and filters

• Select by Name - to select objects by name.
• Select by Boundary - to select objects within a boundary 

shape you define.
• Select by Size - to select objects based on size.
• Invert Selection - to invert the active selection.
• Selection Priority - to specify the priority of selected objects 

in the canvas.
• Selection Filters – to control which objects types are available 

for selection.
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Create 2D sketches
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Chapter Outline

Create 2D sketches
• Create a 2D sketch
• Create geometry in a sketch
• Use constraints to position geometry
• Use dimensions to set the size of geometry
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Learning objectives of this chapter

In this section you will learn how to create sketches and how 
to apply dimensions and geometric constraints. 
After completing this section, you will:
• know the basic workflow for creating a sketch
• be able to create, constrain and dimension a sketch 
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A sketch is an object containing the geometry needed to define 
profiles. Sketches must be created on origin planes, construction 
planes, or a flat model face.

Create a 2D sketch

First step is to start a new 
design where you will 
create geometry:
• Launch Fusion 360
• Start a new design
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Select Sketch > Create Sketch

Create a new sketch
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Select Sketch > Create Sketch
Select the “Top” (XZ) plane

Create a new sketch
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Sketch geometry can be created and edited using 
many available commands. Next, we will create a 
profile using Line command. 

Create geometry in a sketch
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Sketch a profile
• Select Sketch > Line
• Draw the shape from the picture by clicking in the indicated order
• Make sure you connect the last line to the start point, creating a 

closed shape. If correct, the shape is shaded in.
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Constrain the profile

• From the Sketch Palette> 
Constraints select 
Horizontal/Vertical 

• Apply Horizontal/Vertical
on all the lines, except line 1
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Constrain the profile

• From the Sketch Palette> Constraints select Collinear
• Select line 2 and 3
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Constrain the profile

• From the Sketch Palette> Constraints select Coincident
• Select point 4 then, from Browser, the origin of the 

coordinate system
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Dimension the profile
• Select Sketch > Sketch Dimension
• Place dimension on the lines according to the picture
• Select Stop Sketch
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3D modelling
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Chapter Outline

3D modelling
• 3D modelling tools
• Create 3D models
• Edit existing features
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Learning objectives of this chapter

In this section you will learn how to turn a sketch into a
parametric 3D model and to create solid bodies using primitive
shapes.
After completing this chapter, you will :
• be able to use main tools to create 3D models
• know how to modify existing features
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3D modelling tools

There are multiple modelling
tools inside Fusion 360. In this
course we will study only the
solid parametric modelling and
the creation of solid models from
primitive shapes.
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Create a body using Extrude

• Select profile –
click inside the 
profile

• Click Create> 
Extrude

Extrude command creates a 3D solid by extending the shape of a 2D 
object in a perpendicular direction into 3D space.
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Create a body using Extrude

Set the extrude options, according to the picture.
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Cut body using Press Pull

Press Pull command is a selection command that allows quick 
access to either the "Extrude," "Fillet," or "Offset Face" command 
depending on the type of geometry initially selected.
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Cut body using Press Pull

Sketch cutting profile
• Select Sketch > Create Sketch
• Select the LEFT view.
• Select Sketch > Rectangle> 2-Point Rectangle
• Click on point 1 to start the rectangle
• Move the mouse to the line 2 and place of 

the rectangle’s opposite corner
• Click to complete the command
• Select Sketch > Sketch Dimension
• Place the 25 mm dimension
• Select Stop Sketch
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Cut body using Press Pull
Place cut
• Select profile – click inside the rectangular sketch
• Right-click and select Press Pull
• Set the extrude options according to the picture.
• Click OK.
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Create body with Cylinder 
primitive

Cylinder command creates a body by adding depth to a circular 
region.
• Click Create > Cylinder
• Select the bottom surface of the object
• Select the corner 1 to place the cylinder’s center point
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Create body using Cylinder
•Move the cursor until you reach 50 mm. Click to confirm the size.
•Drag the arrow manipulator to set the cylinder height to 120 mm
•Set Operation to Join
•Click OK
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Cut body using Cylinder
• Click Create > Cylinder
• Select the top surface of the cylinder created previously
• Select the center of top surface to place the cylinder’s center 

point
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Cut body using Cylinder
•Move the cursor until you reach 44 mm. Click to confirm the size.
•Drag the arrow manipulator to set the cylinder depth to 115 mm
•Set Operation to Cut
•Click OK
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Create body using Box primitive
Box command creates a rectangular body.
•Click Create > Box
•Select the bottom surface of the object
•Select the corner 1 to place the cylinder’s center point
•Move the mouse to place the box’s opposite corner (point 2)
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Create body using Box
•Set the Box options 
according to the 
picture
•Click OK
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Combine bodies
• Click Modify > 

Combine
• Select Box as Target 

Body
• Select Body 1 as 

Tool Body
• Set Operation to Cut
• Check Keep Tools
• Click OK to finish
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Remove extra body
A new body has been created and must be removed – right 
click on the un-needed body, in Browser.
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Join bodies

•Click Modify > 
Combine
•Select first body as 
Target Body
•Select second body as 
Tool Body
•Establece la operación
Join
•Deselectionar Keep 
Tools
•Clic en OK para finalizar

There are 2 bodies now and will join them to have only one. 
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Modificar la caja usando Shell

• Clic en Modify > Shell
• Seleccionar la 

superficie del 
superior  Box

• Establecer Inside 
Thickness en 3 mm

• Establecer la 
Dirección en Inside

• Clic en OK para 
finalizar
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Fillet edges
• Hold the Shift key and select the two edges shown in the image
• Right-click and select Fillet
• Set the Radius to 10 mm
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Chamfer edges
• Hold the Shift key and select the two edges shown in the image
• Right-click and select Chamfer
• Set the Distance to 5 mm
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Use materials to control 
the appearance
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Chapter Outline

Use materials to control the appearance
• Apply and edit materials
• Modify appearance
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Learning objectives of this chapter

In this section you will learn how to use physical materials and 
visual materials.
After completing this chapter, you will be able to:
• apply and edit materials
• modify the design appearance
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Apply and Edit materials

There are two types of 
materials in Fusion360:
• physical materials - control 

the appearance and 
engineering properties of a 
component.

• appearance materials -
override the appearance 

only. 
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Add Physical Material

• Click Modify > Physical 
Material

• In the Physical Material 
dialog box, expand the 
Plastic folder

• Drag ABS Plastic onto the 
model. The material and 
color of the model are 
modified

• In the Physical Material 
dialog box, click Close
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Modify the Appearance

•Right-click the model. Click Appearance
•In the Appearance dialog box, expand the Paint > Glossy folder
•Scroll down the list to Paint – Enamel Glossy (Red)
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Modify the Appearance

•Drag Paint – Enamel Glossy (Red) 
onto the model. The material 
color is modified. Note that the 
physical material is still ABS.
•In the Physical Material dialog 
box, click Close
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Export models as STL file
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Learning objectives of this chapter

In this section you will learn how to export the 3D models as 
STL file.
After completing this chapter, you‘ll be able to export the 3D 
models as STL file.
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STL files

STL (STereoLithography) is a common file format used in 3D
printing and contains the 3D model which will be printed. STL
is a triangulated representation of a 3D CAD model.
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Export models as STL file

· In the Browser, right click on 
Body1 > select Save as STL

· In the „Save as STL" dialog box 
select Refinement as Medium

· Click OK
· Browse  to the folder where you 

want to save the STL file
· Click Save
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Useful Topic Related 
Links

https://www.autodesk.com/products/fusion-360/overview

http://help.autodesk.com/view/fusion360/ENU/
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Select a STL model from online 
resources
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Aim and Learning Outcomes

Module Aim: To equip students with basic understanding of 
using STL files resources for searching and 
downloading models for 3D printing technology

Number of Hours: 3hrs

Learning outcomes: • Theoretical knowledge and practical skills on 
how to access STL files from online 
repositories/marketplaces/search engines, 
to search and to download the desired
model
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Lecture Outline

• Access STL models online resources 
(repositories/marketplaces/search engines) such as: 
Thingiverse, GrabCAD, Pinshape, Yeggi, etc.:
• Browse the repositories and libraries and download STL 

models
• Illustrative examples
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Access STL models from 
online resources
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• STL models can be downloaded, free or paid, from several
repositories, marketplaces or search engines such as:
Thingiverse, GrabCAD, SketchFab, Pinshape, Yeggi, Autodesk
123d, Pinshape, CGtrader, etc.

• These are offering STL files (in Binary or ASCII formats)
usually grouped in categories for making the search and
selection easier, but also 3D CAD files in neutral or native
formats that can be transformed in STL files and then used
for 3D printing.

Access STL files repositories
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• STL files can be also uploaded on these repositories for
sharing creative and useful ideas/objects

• Some of these repositories are owned by 3D printers
manufactures:

• Examples: Thingiverse by Makerbot, YouMagine by
Ultimaker, Zortrax Library by Zortrax or GrabCAD by
Stratasys.

Access STL files repositories
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• Details on the most important resources for STL files

Access STL files repositories

Name Link Type Free/paid
Thingiverse www.thingiverse.com Repository Free

GrabCAD www.grabcad.com Repository Free
SetkchFab https://sketchfab.com/tags/repository Repository Free

Yeggi www.yeggi.com Search engine Free, paid
Autodesk123d http://www.123dapp.com/Gallery/conte

nt/all
Repository Free

STL Finder www.stlfinder.com Search engine Free, paid
Pinshape https://pinshape.com/ Marketplace Free, paid
CGTrader https://www.cgtrader.com Marketplace Free, paid

Yobi3D https://www.yobi3d.com/ Search engine Free
Zortrax Library http://library.zortrax.com/ Repository Free

YouMagine https://www.youmagine.com Repository Free
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• Workflow for 3D printing a STL model from an online
repository/search engine/marketplace

Access STL files repositories
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• Thingiverse – repository of millions of STL models

Examples – Thingiverse
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• Step 1: Searching database using the term: “catapult” 
determines the display of different models associated with 
this word.

Examples – Thingiverse
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• Step 2: One model catapult is selected (no 1763518) and 
different images of 3D CAD models, a short movie and 
pictures of 3D printed catapult are shown. 

Examples – Thingiverse
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• Step 3: Access information and comments on 3D printed 
variants of the catapult under Made tab

Examples – Thingiverse
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• Step 4: Access information (Summary) on recommended 3D 
printing settings: material, layer width or resolution, nozzle 
diameter, orientation supports, etc.

Examples – Thingiverse
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• GrabCAD – repository for 3D CAD models and STL files
• Requires creating an user account

Examples – GrabCAD
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• Browsing GrabCAD by categories

Examples – GrabCAD
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• Step 1: Searching the word “bracket” on GrabCAD produces the 
results below.  For each model, the format in which the object 
can be found (neutral format or 3D CAD native format) is 
specified. 

Examples – GrabCAD
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• Step 2: Select and download on model of bracket in STL file 
format 

Examples – GrabCAD
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• Step 3: Access information on model or recommended 3D 
printing settings 

Examples – GrabCAD
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• Step 1: Access Pinshape and search a model: “3D watch” –
for example

Examples – Pinshape



This project has been funded with support from the European Commission. This material reflects the views only of the 
author, and the National Agency and European Commission cannot be held responsible for any use which may be made of 
the information contained therein.

2016-1-RO01-KA202-024578

• Step 2: Access information on how to 3D print the 
components and to assembled them. This are presented as 
text and/or using videos.

Examples – Pinshape
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• Step 3: Download and extract each component of the 3D 
watch

Examples – Pinshape
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• Yeggi repository gathers STL models (over 60000) from 
different repositories

Examples – Yeggi
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• Step 1: Search the database using a key word, example: 
“spinner”. Depending selected model, the platform is 
redirecting user to a specific repository (Minifactory, as 
example).

Examples – Yeggi
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• Step 2: Depending selected model, the platform is 
redirecting user to a specific repository (Minifactory, as 
example) from where the model can be downloaded.

Examples – Yeggi
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• STL Finder is a search engine for STL models.
• The search can be performed using keywords or by 

categories.
• Use Filters to establish the repository database

Examples – STL Finder
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• Step 1: Search by keywords: “mobile support”.
• Step 2: Selecting one model redirects the user to 

Thingiverse repository

Examples – STL Finder
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• Zortrax library requires an user account.
• Models on Zortrax Library are included in categories, 
editors choices being also available on the front page

Examples – Zortrax Library
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• Information on the number of visualizations, comments and 
number of downloads for each model is presented on 
website.

Examples – Zortrax Library
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• Search by word: “cube”   –> Select “Folding Cube” model –> 
Press Download project

Examples – Zortrax Library
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• CGTrade platform allows selecting free  or paid models, the 
model format (STL in this case), 3D Print, Collection etc.

• Downloading a model requires creating an user account 

Examples – CGTrade
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• Step1: Create user account
• Step 2: Search and download object: “pencil box” – as an 

example.

Examples – CGTrade
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Check and correct STL files using 
dedicated software
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Aim and Learning Outcomes

Module Aim: To equip students with understanding of using 
dedicated software for checking and correcting 
STL models

Number of Hours: 3hrs

Learning outcomes: • Acquiring knowledge about Netfabb, 
MeshLab, MiniMagics software solutions

• Acquiring knowledge on using automated 
tools/commands for checking and correcting 
STL models

• Acquiring knowledge on using manual 
tools/commands for correcting STL models
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Lecture Outline

• STL models analysis and repair
• Software solutions for STL models analysis and repair:

• Examples: Netfabb, MeshLab, Materialise 3DPrint Cloud
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STL models analysis and 
repair
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Main type of STL models 
errors:
• Missing triangles
• Inverted normals
• Non connected edges
• Bad edges

STL models analysis and repair
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• Analysis and, if necessary, repair of STL models are steps to
be performed before sending the STL file to the 3D printer

• Dedicated software solutions are used for STL checking and
repair

• STL model repair can be performed automatically or manually

STL models analysis and repair
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Software solutions for STL 
models analysis and repair
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• Netfabb software, www.netfabb.com

• Free version options:
• Tools for manually or automated STL checking and 

repair
• Tools for measuring model walls thickness
• Tools for cutting the models

• Automated STL repair options solve many of the usual
problems of this type of file (holes, inverted normal, bad edges,
etc.)

Software for STL models - Netfabb
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• Import and export formats in Netfabb

Software for STL models - Netfabb
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• Opening an existing STL model:
• Project→ Open (or Ctrl+O)
• Project → Add part
• Drag-and-drop model in application

Software for STL models - Netfabb



This project has been funded with support from the European Commission. This material reflects the views only of the 
author, and the National Agency and European Commission cannot be held responsible for any use which may be made of 
the information contained therein.

2016-1-RO01-KA202-024578

• A hand model, which can be used as mobile phone support, is 
used for explaining analysis and automatic repair options in 
Netfabb

Software for STL models - Netfabb

Model 
volume is 
not 
calculated 
because of 
the holes in 
the model.
Model 
dimensions 
on x, y, z axis 
are shown
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• The exclamation mark means the model contains errors.
• A standard analysis is performed.

Software for STL models - Netfabb
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• Analysis results shows that the surface is orientable, but it is 
not closed.

• Standard analysis operation is shown also in Project Tree.
• Other available information:
- Number of holes
- Flipped Triangles
- Bad Edges
- Number of points
- Number of triangles
- Number of edges, etc.

Software for STL models - Netfabb
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• The zone with missing triangles is shown in yellow when 
activating Repair option (red cross sign).

• Automatic Repair is applied with sub-option Default Repair. 
Then Apply Repair and Remove Old parts.

Software for STL models - Netfabb
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• The results of Repair option is shown. A new test analysis
should be performed for checking if the STL model is closed.

• Then the model can be saved and used for 3D printing:
Project → Save, Project → Save As or Export Part → STL.

Software for STL models - Netfabb
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• A bracket model is used for illustrating the manual repair
options in Netfabb

Software for STL models - Netfabb
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• STL model after Automatic Repair is shown.
• Manual operations are used for deleting triangles. Triangle 

are selected (Select triangle option) and then erased (Delete 
key).

Software for STL models - Netfabb
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• Imagines of different steps of Manual repair: selecting 
triangles, deleting triangles

• Automatic Repair option is then applied

Software for STL models - Netfabb
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• Hands-on session (45 minutes)
- Download a STL model from a repository
- Check the STL model using Netfabb
- If the STL model is correct, exported as STL ASCII
- Open STL ASCII file using Notepad and erase several triangles, 

modify vertex coordinates and/or normals orientation
- Save the STL file thus modified
- Open the new STL file in Netfabb and repair it.

Software for STL models - Netfabb
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• MeshLab, www.meshlab.net – solution for inspecting, editing, 
cleaning, healing, inspecting, rendering, texturing and 
converting meshes, including STL models.

Software for STL models - Meshlab
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• MeshLab import and export file formats

Software for STL models - Meshlab
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• MeshLab, interface explained

Software for STL models - Meshlab
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• MeshLab editing options

Software for STL models - Meshlab

• MeshLab cleaning options



This project has been funded with support from the European Commission. This material reflects the views only of the 
author, and the National Agency and European Commission cannot be held responsible for any use which may be made of 
the information contained therein.

2016-1-RO01-KA202-024578

• Making errors visible in the hand support model example

Software for STL models - Meshlab
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• Accesing: Remeshing, Simplification and Reconstruction for 
repairing the defects in the hand support model

Software for STL models - Meshlab
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• Applying Surface Reconstruction Ball Pivoting option for filling 
the gaps in the model

Software for STL models - Meshlab
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• The result of applying Ball Pivoting surface reconstruction

Software for STL models - Meshlab



This project has been funded with support from the European Commission. This material reflects the views only of the 
author, and the National Agency and European Commission cannot be held responsible for any use which may be made of 
the information contained therein.

2016-1-RO01-KA202-024578

• MiniMagics, www.materialise.com/en/software/minimagics
• Loading the hand support model in MiniMagics software or in 

3DPrint Cloud, https://cloud.materialise.com/

Software for STL models - 3DPrintCloud
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• In case of MiniMagics application, repair options are 
automatic and they are available in 3DPrintCloud

• User account is needed

Software for STL models - 3DPrintCloud
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• Hand STL model is uploaded and mm is set as measure unit.
• Model Repair option is then applied

Software for STL models - 3DPrintCloud
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• The results of automatically repairing the model

Software for STL models - 3DPrintCloud
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• Other options available in MinigMagics 3DPrintCloud:
- Scaling
- Wall thickness analysis
- Triangles reduction
- Parameter extraction

Software for STL models - 3DPrintCloud
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• Hands-on session (15 minutes)
- Using the same model as in first hands-on session, repair the 

model with MiniMagics/3DPrint Cloud 

Software for STL models - 3DPrintCloud
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3D print models using online 
services
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Aim and Learning Outcomes

Module Aim: To equip students with understanding of on 
how to access online service bureaus or 
platforms for loading model, estimating 3D 
printing costs and placing orders for 
manufacturing the desired object

Number of Hours: 3hrs

Learning outcomes:  Knowledge on how to access 3D Printing 
online services providers

 Knowledge on how to upload STL model, 
select material, 3D Printing process, 
machine

 Knowledge on how to evaluate cost, 
delivery time and access other information 
provided by producers/platforms
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Lecture Outline

• 3D printing online services:
• File formats accepted by 3D printing service providers
• Workflow for using 3D printing online services

• 3D printing using platforms such as: 3DHubs, Sculpteo, 
Shapeways, i.Materialise, Ponoko
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3D printing online 
services
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• Some 3D printing online services providers with instant quotes:

3D printing online service providers

Provider Website Type of business 3D Printing process Materials

3D Hubs www.3dhubs.com B2C, B2B FDM, SLS, Sla, Polyjet, Thermoplastics, Resins, Metals, 
Paper

Shapeways www.shapeways.com B2C, B2B SLS, FDM Thermoplastics, Metals, 
Sculpteo www.sculpteo.com B2C, B2B FDM, SL, SLS, SLM, 

CLIP, Polyjet, DMLS
Plastics, Resins, Metals,

i.materialise https://i.materialise.co
m/

B2C, B2B Thermoplastics, 
Metals, Ceramics, 

Resins

FDM, SLS, SL, Ceramic Jet, DMLS, 
Polyjet

Ponoko www.ponoko.com B2C, B2B FDM, SLS, Polyjet Thermoplastics, Metals
Protolabs www.protolabs.com B2B FDM, SL, SLS, DMLS Thermoplastics, Nylon, Metals
StrataSys 

Direct
www.stratasysdirect.co

m
B2B FDM, SLS, Polyjet, 

DMLS, LS
Thermoplastics, Metals, Acrylic

QuickParts http://www.quickparts.
3dsystems.com/solutio

ns

B2B FDM, SL, SLS, Polyjet, 
DMLS

Thermoplastics, Resins, Metals, 
Nylon

BuildParts www.buildparts.com B2C, B2B FDM, Polyjet, SLA, SLS, 
CLIP

Thermoplastics, Metals, Resins

Make XYZ www.makexyz.com/ B2C, B2B FDM, SL Thermoplastics, Nylon, Resins
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• File formats accepted by 3D printing service providers 
(examples):

- 3DHubs: STL, OBJ
- Shapeways: STL, OBJ, X3D, DAE, VRML
- Sculpteo: STL, OBJ, SKP, OFF, PLY, KMZ, 3DS, AC3D, IPT, DAE, 
MD2/MD3, Q3O, COB, DXF, LWO, IGES, STP, VRML, SCAD, ZIP, 
RAR, TGZ, CARPART, CATPRODUCT, CGR, SLDPRT, SLDASM, IGES, 
IGS, SAT, 3DM, 3MF, PRC, U3D, X_T
- i.materialise: STL, OBJ, WRL, SKP, DAE, 3MF, 3DS, IGS, MODEL, 
3DM, FBX, PLY, MAGICS, MGX, X3D, STP, STEP, PRT, MATPART
- Ponoko: STL, DAE, VRML
- Make XYZ: STL, OBJ, ZIP, STEP, STP, IGES, IGS, 3DS, WRL

3D printing online service providers
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• The workflow for all 3D printing online providers consists in
the following steps:

1. Access 3D printing service provider webpage
2. Upload model (using one of the file formats accepted, usually

STL)
3. Choose 3D printing process and/or material
4. Decide if you want to 3D print the model based on the

received quote and delivery time/conditions

3D printing online service providers
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3D printing online 
providers
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• 3D Hubs
• Gathers thousands of 3D printers owners from all over the 

world
• Offers suggestions regarding building material depending on 

price, surface quality, functional

3DHubs
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• 3D Hubs working flow

3DHubs
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• A STL model was uploaded as example and SLS process and 
Nylon material were chosen for 3D printing the part.

3DHubs
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• The list of suggested 3D printing service providers (enrolled on 
3DHubs). They can be sorted depending on how close are to 
the users’ location, price, etc.

• Delivery date is also mentioned (the order was placed on 10 
April) 

3DHubs
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• Material recommendation – the user should answer some 
questions regarding material (metal or plastic), material 
properties and accuracy. Several steps are presented:

3DHubs
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• Shapeways
• Requires creating an user account
• Offers 3D printing services, as well as a library for STL models

Shapeways
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• The model should be check for errors before upload.
• After model upload, information on size, volume and surface 

area is available. Also a 3D model viewer allows visualizing the 
model (zoom and rotate options are available).

Shapeways
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• The next steps are: choosing a material for the object and 
setting a building orientation.

• Materials: strong & flexible plastics, metals, was, steel, etc.

Shapeways
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• Setting building orientation in Shapeways using the arrows 
from the down-right. Zoom option is available.

Shapeways
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• Sculpteo
• User account is required

Sculpteo
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• Uploading and visualizing a STL model

Sculpteo
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• Information on price and shipping date is provided instantly 
after choosing material and 3D printing process.

Sculpteo
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• The possibility to review the model for checking solidity or wall 
thickness.  

Sculpteo
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• Sculpteo can also generate a 3D printing dossier containing all 
the information and checks presented

Sculpteo
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• i.Materialise

i.Materialise
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• Upload model, choose material, color, finishes and quantity
• The price is displayed instantly

i.Materialise
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• BuildParts
• User account is needed

BuildParts
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• True-Quote option in BuildParts
• Steps: upload model; choose material and process; choose 

building orientation, resolution, finishing and quantity.

BuildParts
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• Model is uploaded and manually oriented

BuildParts
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• Generating quote for the model

BuildParts
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• Hands-on session:
- Download a STL file from an online repository
- Choose at least two 3D printing service providers and upload 

your model
- Choose material and/or process and compare manufacturing 

prices 

BuildParts
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3D printing on low-cost filament 
deposition 3D printer
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Aim and Learning Outcomes

Module Aim: - To equip students with knowledge on 
setting building orientation, process 
parameters and build an object on a low-
cost 3D printer, as well as with knowledge 
on 3D printer software

Number of Hours: 4hrs

Learning outcomes: · Knowledge on importing STL file in 3D 
printer software, scale and position object 
within building envelope, set process 
parameters, slice the model

· Knowledge on applying post-processing  
operations for 3D printed objects
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Lecture Outline

• 3D print an object using Z-suite for Zortrax 3D printer
• 3D print an object using Cura for Ultimaker printers
• 3D print an object using Slic3r software for RepRap 3D 

printers
• 3D print an object using ReplicatorG for RepRap 3D 

printers, Makerbot Replicator, Thing-O-Matic
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3D print an object using Z-
suite for Zortrax 3D printer
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• Z-Suite software for Zortrax 3D printers
• A virtual 3D model is designed or downloaded from repositories 

as STL file.
• If object is modelled in a 3D CAD application, save it as STL file.
• Verify and, if necessary, correct the STL file in Netfabb

3D print using Z-suite software

3D CAD modeling

Netfabb 
STL analysis



This project has been funded with support from the European Commission. This material reflects the views only of the 
author, and the National Agency and European Commission cannot be held responsible for any use which may be made of 
the information contained therein.

2016-1-RO01-KA202-024578

• Open STL file in Z-Suite software using drag-and-drop or 
with Add Object (+ icon )

• Mouse buttons can be used for manipulating views (MB1-
rotate, MB2-zoom, MB3-pan).

3D print using Z-suite software
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• Orient model within the working space so that to fulfill user 
criteria such as: minimize support structure volume, place 
holes with axis along building direction, place important 
surfaces in vertical or horizontal positions, etc.

• Rotation can be performed around x, y and z axes. 

• Object is selected by placing the mouse on one of its 
surfaces and clicking MB3.

3D print using Z-suite software
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• Model orientation within working space

3D print using Z-suite software

Object rotated with 270deg around y axis
Orientation 1

Orientation 2
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• Also object can be move on the platform using Move 
button.

• Object can be resized (scaled) with Resize button with the 
same value in x, y and z directions

3D print using Z-suite software
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• Object can be split using Split option. As an example, the 
object is split with  plane.

3D print using Z-suite software

Split with x plane

Split plane

Two objects

- Each object resulted from Split option can be exported.
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• Set process parameters: material, layer thickness, infill, 
surface layers, support angle deposition, speed etc. 

3D print using Z-suite software
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• For each material, a list of layer thicknesses is available.
• Prepare to print option is accessed for starting the slicing 

process based on the set process parameters. Nozzle paths 
for deposition model material and support material are 
generated. In Z-Suite, the model material is displayed in 
blue, while the supports are displayed in grey. Each layer 
can be visualized using Pause option from Tools.

• Information about building time (estimated) and filament 
usage (in meters and grams).

3D print using Z-suite software
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3D print using Z-suite software

Estimated build time and 
filament usage

Base support 
structure

Part

Support 
structure

Layer by layer 
visualization

• Layer by layer visualization
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3D print an object using 
Cura for Ultimaker printers
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• Cura software for Ultimaker 3D printers
• Opening an STL file. Model is placed in the middle of the 

building platform. It is sliced immediately after import and 
information on build time and filament usage is displayed.

3D print using Cura software
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• Object can be moved on the platform using MB1, can be 
rotate using MB3 and zoomed using MB2 (also pan). For 
these actions, buttons can also be used.

3D print using Cura software
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• Layers visualization

3D print using Cura software
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• Process parameter settings

3D print using Cura software
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• Custom 3D printer settings

3D print using Cura software
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• Example of a Gcode file

3D print using Cura software
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3D print an object using 
Slic3r for RepRap printers
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• Slic3r software for RepRap 3D printers
• Open STL file using Add option
• View manipulation: MB1-rotate, MB2-zoom and pan, MB3-pan

3D print using Slic3r software
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• Scale (uniform) object in Slic3r

3D print using Slic3r software

• Cut object in Slic3r
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• Print settings Filament settings Printer settings

3D print using Slic3r software
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• Infill settings: layer fill density, fill pattern, top/bottom fill 
pattern

3D print using Slic3r software
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• Filament diameter settings, usually 1.75 mm or 3 mm.

• Bed shape and size settings.

3D print using Slic3r software
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• Layers visualization

3D print using Slic3r software

Establish layer



This project has been funded with support from the European Commission. This material reflects the views only of the 
author, and the National Agency and European Commission cannot be held responsible for any use which may be made of 
the information contained therein.

2016-1-RO01-KA202-024578

• Layers visualization

3D print using Slic3r software
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• More options are available in Expert mode which can be 
accessed from File menu.

3D print using Slic3r software
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• Speed settings Advanced settings

3D print using Slic3r software
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3D print an object using 
ReplicatorG
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• ReplicatorG for RepRap 3D printers, Makerbot Replicator, 
Thing-O-Matic

• Should be run as Administrator and requires Python
• Open STL file using Open option from File menu

3D print using ReplicatorG software

Object view
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• Object can be moved, rotated, mirrored (part is oriented in 
mirror reflected in x, y or z) or scaled.

Move object on platform Rotate Scale

3D print using ReplicatorG software
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• Accessing estimate print time option: 3h 1min

3D print using ReplicatorG software
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• 3D printer control panel

3D print using ReplicatorG software
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• List of 3D printer drivers in ReplicatorG

3D print using ReplicatorG software
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• Toolpath generation Gcode->Generate;  In Preferences set 
the path to Python interpreter

• Skeinforge or another slicing software such as Slci3r is 
required. 

3D print using ReplicatorG software
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• Slicing results

3D print using ReplicatorG software
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• Example of generate Gcode

3D print using ReplicatorG software
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3DP and entrepreneurship
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Aim and Learning Outcomes

Module Aim: To inspire and help students to start a 3D 
Printing based business

Number of Hours: 3hrs

Learning outcomes: • Knowledge on the opportunities offered by 
3D printing in entrepreneurship

• Understanding the requirements of a 3D 
printing business
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Lecture Outline

• Examples of 3D businesses and start-ups 
• Funding sources
• Skills required for a 3DP based business
• Opportunities for freelancers
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Examples of 3DP businesses 
and start-ups
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3D Printing offers a huge opportunity of investment, with 
more and more entrepreneurs and potential clients being 
interested in the possibilities it offers.

3DP businesses and start-ups 
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3DP printing services

Companies that print 
objects on your behalf
Examples: 

• Shapeways
• 3D Hubs
• i.materialise
• Sculpteo
• iMakr
• MakeXYZ
• Ponoko



This project has been funded with support from the European Commission. This material reflects the views only of the 
author, and the National Agency and European Commission cannot be held responsible for any use which may be made of 
the information contained therein.

2016-1-RO01-KA202-024578

3DP printing repositories

Platforms that offer 
3D printing models
Examples: 

• Thingiverse
• GrabCAD
• Sketchfab
• YouMagine
• Cults3D
• Zortrax Library
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3DP printing hubs

Networks of 3D 
printers.
Examples: 

• 3DHubs
• MakeXYZ
• Fiverr
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Other 3DP business ideas

- 3DP training providing
- 3D printers manufacturing
- Prototyping as a service
- 3D printed fashion
- 3D printed parts and 

products
- 3D printed food
- 3DP models creation
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• Design and manufacture 3D printers
• Source and 3D print parts, assembly, calibrate and sell 3D 

printers

3D printers manufacturing

Examples:
• Makerbot, Formlabs (USA)
• BQ, BCN3D (Spain)
• WASP, Roboze, Sharebot (Italy)
• Zortrax, Sinterit (Poland)
• Symme3D, Build3DParts (Romania)
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Huge variation of 
designs can be 

created using 3D 
printing .                 

Customized objects
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Prototyping

Prototyping is the most important application of 3D 
printing.
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3D printed fashion - bags

Odo Fioravanti – Clutch Berna

The Berna Clutch of Odo Fioravanti, launched in 2017 in Paris. It has 
curved layers and is inspired by an unique urban structure of the city 
of Bern.  It is a limited series and having it 3D printed came as an 
efficient solution from the perspective of costs.
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3D printed fashion - jewels

There are numerous examples regarding jewelry;

Omri Revesz created 
the collection 
Penrose which starts 
from a rigorous 
geometric architecture 
that never repeats 
itself identically 
because of the 
asymmetrical model.
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It is based on researching the 
way in which models and 
forms appear in nature to 
create mathematical patterns 
and simulations that allow 
them to create more 
complicated objects, unique 
and personalized with the 
help of 3D printing. 

3D printed fashion - jewels

Nervous System

Nervous System, another successful business, creates 
jewels inspired by science and technology.
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Designer Danit Peleg, created an entire collection 
using her home 3D printers. 

3D printed fashion - clothing



This project has been funded with support from the European Commission. This material reflects the views only of the 
author, and the National Agency and European Commission cannot be held responsible for any use which may be made of 
the information contained therein.

2016-1-RO01-KA202-024578

Parts & prototypes for watches

ZGOD Watches. ZegarkiFossil watches 

ZGOD. Zegarki, a Polish business, creates watches 3D printing the 
frames.
Fossil uses 3D printing for watch prototypes. The design can be 
adjusted any time and reprinted in 3D, producing the prototype is 
thus less time consuming and a lot less expensive.
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A variety of models can be easily produced by 3D printing.

3D printed toys
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Medical  uses of 3D printing include prosthesis and body 
parts.

3D printed medical devices
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3D printed customised objects
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Various types of edible designs can be created in 3D 
printing

3D printed food
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Funding sources
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Overview of sources:
1. Personal investment
2. Venture capital and private investors
3. Business incubators and accelerators 
4. Bank loans 
5. Angel Investors 
6. Grants
7. Crowdfunding

Funding opportunities
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Funding opportunities- Crowdfunding
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Skills required for a 3DP 
based business
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Depending on your business idea, you might need some 
specific skills to successfully run your business.
These skills may be gained by taking the 3DP course.

Required skills 
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Creativity – Generating new concepts
Drawing – envisaging the objects in pen and paper

Design skills 
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• insights into the needs of clients
• market analysis

Marketing Skills
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• Math, Sciences, Physics, Chemistry, Mechanics

Engineering and Technical Skills
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IT skills
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Opportunities for 
freelancers
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• Demand for freelance 3D printing expertise is growing 
fast

• Most in-demand jobs requiring 3D printing expertise:
• Industrial and mechanical engineers
• Software developers, applications
• Designers
• Marketing managers

Opportunities for freelancers
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• Upwork
• Guru.com
• CAD crowd
• peopleperhour
• Freelancer
• xplace

Freelancing websites
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Useful Topic Related Links
• Upwork.com
• Guru.com
• CAD Crowd
• 3D Printing Job Board
• The MediaBistro
• https://www.symme3d.com/
• https://www.kickstarter.com/
• www.indiegogo.com
• https://3dprinting.com/3d-printing-

service/
• 10 Amazing 3D Printing Startups
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Design with 3D printing in mind
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Aim and Learning Outcomes

Module Aim: To equip students with basic knowledge on 
defects typically encountered in 3D printed 
parts and 3D printing design rules for parts and 
assemblies in order to minimise the occurrence 
of such defects. 

Number of Hours: 3hrs

Learning outcomes: • Acquiring knowledge on defects associated 
with 3D printed parts fabricated by FDM

• Understand the influence of building 
orientation over parts’ quality and 
mechanical properties

• Acquiring knowledge on 3D Printing design 
rules for parts and assemblies
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Lecture Outline

• Types of Defects in 3D Printed 
FDM Parts

• Role of Building Orientation in 
3D Printing

• Design Rules for 3D Printing 
Parts and Assemblies
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Fused Deposition Modelling (FDM) is going to be taken as the case-
study 3DP technology for defects

Lecture Focus

Other….

E.g. Laminated Object 
Manufacturing 
(LOM):

Raw material:

Paper

3D Printing Technology

Fused Deposition 
Modelling (FDM)

Raw material state: 
Polymer filament

Stereo Lithography 
(SL)

Raw material: 
Photosensitive 
Liquid Resin

Selective Laser 
Sintering (SLS)

Raw material:

Powder (including 
polymer, ceramic, 
metal)

Lesson focus
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Types of Defects in 3D 
Printed FDM Parts
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• Causes of defects are classified according to the stage in which 
they happen:

• This classification applies to 3D Printing processes in general, 
not just FDM

Defects in 3DP FDM Parts

3D CAD 
Modelling

STL file 
preparation

Data preparation defects Part building defects

3D Printing 
process

Post-processing 
defects
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• Inaccuracies related to data preparation, such as due:
1. STL file generation: inherent errors due to tessellation 

of 3D CAD model. The resolution of STL files can be 
controlled during their generation in a 3D CAD system.

Defects Related to Data Preparation

Medium STL file 
resolution

Low STL file 
resolution
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2. missing support structures: software can erroneously 
omit support structures which result in defects during 
the fabrication stage

Defects Related to Data Preparation

Defective features 
on the model due 

to missing support 
structures 
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• Defects related to the FDM process include:
1. Gaps between fill and outline: the infill uses a 

different pattern that the part boundary

Defects Related to FDM Process

Infill
Part Boundary
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Blobs

2. blobs: which may appear on the surface of the FDM 
model, due to the fact that the printer nozzle moves 
back on forth in the x-y plane

Defects Related to FDM Process
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Staircase effect

3. staircase effect: due to the slicing of the 3D CAD models 
in layers

Defects Related to FDM Process
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4. wrong calibration of the 3D printer: which can lead to a 
disastrous built

Defects Related to FDM Process
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5. support structure sticking to 
part: sometimes it is difficult to 
remove support structure, 
probably do to improper 
temperature settings.

6. warpage: part can get warped 
for various reasons, e.g. 
incorrect built orientation, over-
usage of base plate etc.

Defects Related to FDM Process

Support structure sticking to part
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• Defects related to FDM post-processing include:
1. Unremoved support material: there can be internal 

closed features (e.g. roof in the prototype building 
below) which makes it difficult to remove support 
material)

Defects Related to FDM Post-Process

Entrapped support 
material 
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Role of Building 
Orientation in 3D Printing
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• Part orientation plays a crucial role in FDM, in particular on:
1. the strength of the part (remember FDM parts are weak in 

the vertical direction)
2. the type and amount of support material which is utilised
3. hence the time required to finish off built

Role of building orientation

Support material Build material
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How Does 
FDM Build 
Orientation 
Affect a 3D 
Printed Part?

Affect of Orientation on 3DP parts

https://www.youtube.com/watch?v=oyukaFkI_GQ
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Design Rules for 3D 
Printing Parts and 
Assemblies
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• The design rules have been classified to reflect the three main 
stages of the 3D printing cycle:

Design Rules for 3DP FDM Parts

3D CAD 
Modelling

STL file 
preparation

Design Rules For Data Preparation Design Rules for 
Fabrication

3D Printing 
process

Design Rules for 
Post-processing
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1. Add form features (e.g. 
pockets, ribs, channels and 
holes) in order to improve the 
mechanical properties of the 
part, yet shorten building time 
and reduce material costs

2. In case of small holes, it is 
advisable to look at the least 
diameter of the extruded 
filament, as this will dictate the 
size which can be achieved 

Design Rules For Data Preparation

Adding a pocket to reduce 
material
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3. In case of assemblies, 
sufficient clearance (e.g. 
0.5mm) between mating parts 
must be taken into account.

N.B.: This varies from one FDM 
printer to another – so it is 
advisable to look at the guidelines 
issued for specific FDM printer 
models and makes.

Design Rules For Data Preparation
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4. Add holes, pockets etc. to 
insert other components, such 
as RFID tags, electronic circuitry 
items, metal threaded inserts, 
during the build process. (In 
most cases, the build process 
can be paused.) 

5. Try to avoid sharp corners as 
much as possible as these act 
as stress concentrators for FDM 
parts

Design Rules For Data Preparation

Round corners to eliminate 
stress concentration
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Procedure to 
insert metal 
items in FDM 
parts

Inserting Metal Items in FDM parts

https://www.youtube.com/watch?v=A_BcU7ipHew
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5. It is advisable to design the 
minimum wall thickness 
according to the layer 
thickness.

E.g. if the wall thickness (T) of the 
part is 0.3mm, then the layer 
thickness (t) is 0.1mm; if T = 
0.75mm,  t = 0.25mm. 
In this way, the staircase affect 
would be minimised 

Design Rules For Data Preparation
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1. Material selection plays a 
fundamental role in the 
properties of the part, including 
mechanical, thermal, chemical 
and electrical properties.

2. Material has an influence on layer 
thickness, hence a direct 
influence on surface smoothness 
(e.g. min. thickness for ABS is ca. 
0.13mm whereas for PC is ca. 
0.18mm)

Design Rules For FDM Fabrication

ABS cartridge used in FDM
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3. Select building style (i.e. density by which filament is 
deposited – e.g. sparse – high density) depending on the 
intended function of the printed part. 

This parameter has a direct effect on mechanical properties, 
material consumption and build time  

Design Rules For FDM Fabrication
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4. In the 3DP machine software it is advisable that you check 
that the STL model units match those of the STL scale. 

Design Rules For FDM Fabrication
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5. If you want to increase the quality of the surface finish and 
accuracy, opt for the smallest layer resolution

Design Rules For FDM Fabrication
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Results 
obtained 
when 3D 
Printing using 
PLA on FDM 
with different 
speeds

FDM Defects Due to Different Speeds

https://www.youtube.com/watch?v=BBQTD9_34sQ
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1. Add holes from which soluble 
support structure material can 
be drained during post-
processing.

2. The more support structures 
you have, the less fine the 
surface finish will be. Thus, try 
to reduce support structures 
when preparing the file for 3D 
printing

Design Rules For FDM Post-Processing

Scaled down model of an Egyptian mummy head 
with support material entrapped in chin area 
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Useful Topic Related 
Links

Dedicated CAD package on Design for 3DP

FDM for End-Use Parts:
Tips and Techniques for Optimization

Inserting Metal Inserts Into 3D Printed Parts
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Boosting entrepreneurial spirit, 
creativity and innovation-case studies
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Aim and Learning Outcomes

Module Aim: To equip students with basic understanding of 
3D Printing business 

Number of Hours: 2hrs

Learning outcomes: • Understanding the impact of 3D printing 
technology in various businesses

• Acquiring knowledge of how to build a start-
up based on 3D printing
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Lecture Outline

• 3D Printing case studies in architecture and art
• 3D Printing case studies for the medical field
• 3D Printing technology as support for innovation and 

creativity
• 3D Printing case studies for training and education
• 3D Printing case studies in engineering/industry
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3D Printing case studies in 
architecture and art
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3D printing - revolutionary and innovative solutions for architectural
companies, for museums, national heritage buildings and also for
regular customers.

3D Printing in architecture and art
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Benefits:
• enhancing productivity: any 
complicated  design is tangible very 
fast; 
• using many different colours and 
materials (recycling included);
• flexible to client changes;
• re-edit, re-used, re-print, shared.

3D Printing in architecture and art
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3D Printing case studies 
for the medical field
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3D bio printing – the age when 
the machines we have built are 
building bits and pieces of us. 
• Technology: fusing or depositing 
materials such as plastic, metal, 
ceramics, powders, liquids in layers;
• Visualization: help preparing and 
plan a complex surgical operation. 

3D Printing in the medical field
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Prosthetics for knee replacements, hands 
or legs amputation, fracture support 
casts, eyes, noses for patients with facial 
disfigurement, ex etc.
• functional, versatile, easily customized;
• realized within a day;
• affordable prices.

3D Printing in the medical field
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Prosthetics – 3D printed robotic arms 
and legs
• only in USA, close to 200,000 
amputations are performed each year;
• easier and quicker printing;
•easier and quicker assembly;
• low price solution 3DP prosthetic with 
respect to classic technologies. 

3D Printing in the medical field
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Prosthetics eyes
• a 3D Printer can produce 150 prosthetic 
eyes/hour and reducing the cost by 97% 
of the existing handmade versions.

Prosthetic ears
• hundreds of thousands of people have 
suffered ear injuries due to gunshot 
wounds, cancer of the ear or micotia, a 
malformation of the external ear;
• scientists are creating new ears with 3D-
Printing and human stem cells.

3D Printing in the medical field
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3D bio printing tissues & organs
• a bio printing machine is capable to print human tissues;
• 3D printed skin for burned people;
• Challenge: keeping larger tissues alive, finding materials for 3D 
bio printing.
• 3D printed heart helps develop lifesaving multi-steerable Sigma 
Catheter.

3D Printing in the medical field
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Dental 3D Printing - Teeth, 
Implants, Dentures and Crown;
• personalized, accurate model;
• quick making;
• clean process - a lot less messy 
than plaster method;
• various materials;
• affordable price;
• easy to store in digital 
formats.

3D Printing in the medical field
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3D Printing in Maxillofacial 
and Oral Surgery – dental 
implants and crowns;
• helps dentist to diagnose and 
decide about the treatment;
• create templates and surgical 
drill guides for birth defects, 
injury or receding bone surgery;
• duration of the process: 
approx. one hour.

3DP in Medicine and Healthcare
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3D Printing technology as support 
for innovation and creativity
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Print your own bionic limb - Open Bionics startup 
• allows anyone in the world to download and 3D print their own 
bionic limbs; 
• the business project - Low-cost bionic hands that look and feel 
good - won the finals of Intel's “Make it wearable” Challenge 
($250,000).

3D Printing-Creativity and Innovation
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Integrated Energy System
• clean energy technologies into a 3D-printed building and vehicle;
• connect a natural-gas-powered hybrid electric vehicle with a solar-
powered building to create an integrated energy system.

3D Printing-Creativity and Innovation
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3D Printing case studies for 
training and education



This project has been funded with support from the European Commission. This material reflects the views only of the 
author, and the National Agency and European Commission cannot be held responsible for any use which may be made of 
the information contained therein.

2016-1-RO01-KA202-024578

• stimulating creativity and 
innovation;

• encouraging artistic 
potential; 

• promoting team work; 

3D Printing in training and education

• create responsible digital 
citizens;

• making everything hands on; 
• solving real world problems.

Revolutionizing the classroom
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Revolutionizing the 
classroom
• Chemistry – models of 
complex molecule structures 
and substances;
• Biology – studying cross 
section of different organs, 
bone structures.

3D Printing in training and education
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Revolutionizing the 
classroom
• Design and Engineering –
students can print their own 
prototypes: cars, engine 
parts etc.

3D Printing in training and education
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Revolutionizing the 
classroom
• History – students can print 
historical artifacts for 
examination, historic 
buildings for examination;

3D Printing in training and education
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Revolutionizing the classroom
• Games – students can print old games 
elements or can invent new games;
• Musical instruments – new design for 
regular instruments or creating new ones.

3D Printing in training and education
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3D Printing case studies in 
engineering/industry
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Revolutionizing the automotive 
industry
• Engine design – new models
•3D Printing - the most cost-effective and 
time-saving method in the designers tool 
box to refresh their models 

3D Printing in engineering/industry
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Changing the industry
• manufactures use 3D printing for their 
propeller designs
• revolutionized the way they create 
prototypes and designs

3D Printing in engineering/industry
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Producing factory goods
• Opportunity for smaller 
companies allowing them to 
compete with bigger companies 
and offer consumers choice 
• Repair and maintenance market

3D Printing in engineering/industry
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Producing factory goods
• Cheaper and more efficient 
production for auto, medical, 
and aerospace

3D Printing in engineering/industry
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Useful Topic Related Links

•3D Printer a Game Changer for Architecture 
Design - https://www.youtube.com/watch?v=cOaqRkLP4lI

• Sagrada Familia, 3D Printed model 
https://www.youtube.com/watch?v=UJ8NcKNlZzg

• First 3D printed house builded on site
http://apis-cor.com/en/about/news/first-house

• 3D Printing for Architects: 
http://my3dconcepts.com/3dp-for-architects-lm/
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Useful Topic Related Links

• The bioprinting process 
https://www.youtube.com/watch?v=s3CiJ26YS_U

• Normal 3D Prints Totally Customized Earphones in 
2 days: https://www.youtube.com/watch?v=5YB8BjOn6B0
• https://www.youtube.com/watch?v=XvcpC424HAI

• Painted Arm Prosthetic for a 5 year old girl: 
https://www.youtube.com/watch?v=JDL16rmwgHw

• 3D Printing in Education
https://www.youtube.com/watch?v=X5AZzOw7FwA
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Future of 3D printing 
technologies
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Aim and Learning Outcomes

Module Aim: To present an overview of the 3D printing 
technologies future

Number of Hours: 2hrs

Learning outcomes: • Understanding the potential risks and 
regulations related to 3D printing 
technologies

• Acquiring knowledge on 3D printing trends 
and developments
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Lecture Outline

• Myths and reality in 3D Printing
• 3D Printing risks and regulations
• 3D Printing trends and developments
• Examples
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Myths and reality in 3D 
Printing
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The myths are causing a mix of enthusiasm and disappointment 
with 3D printing technology, potentially slowing its wider adoption 
and development.

Myths and reality in 3D Printing

Myth Reality
3D printers cost too much The price range is very wide 

and starts from about $100
3D printing is only for plastics Lots of other materials can be 

3D printed: metal, wood, 
resins, carbon fiber, bio-
materials, food, concrete, etc.
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Myths and reality in 3D Printing

Myth Reality
3D printers can print 
human organs

We cannot 3D print organs today

Things are quicker to 
make on a 3D printer

3D printing is slower than 
conventional production processes

Every home will have a 3D
printer, soon

There are too few applications for 
the average person to justify the 
costs and efforts involved with 
purchasing and operating a 3D 
printer.
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Myths and reality in 3D Printing

Myth Reality
Some things are 
cheaper to make on a 
3D printer

3D printing makes prototyping 
phase cheaper but end products are 
still not cheaper to make on a 3D 
printer

3D printing is for large-
scale manufacturing

3D printing is suitable for 
customized production. It can be 
convenient to 3D print small batches 
of highly complex products
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3D Printing risks and 
regulations
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3D printing technology allows designs and products to be copied 
and replicated easily. 

3D Printing risks – Intellectual property
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Blueprints for 3D products are software files so they can be:
• Stolen and used to 3D print products
• Manipulated by hackers

3D Printing risks – cyber risks
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3D printing technology blurs boundaries between the different 
roles in the production chain. 

3D Printing risks – liability

Who’s responsible for damages 
caused by a 3D printed object? 
The blueprint creator? The 3D 
printing provider? The person 
who printed the object?

A clear legal framework needs to be developed. 
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3D printing technology simplifies the 
manufacture of counterfeit goods. 
Big concerns are related to sensitive 
sectors, like aerospace and medical.

3D Printing risks – counterfeiting
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Regulations is needed especially for controlling 3D printed objects 
for potential criminal use as for example guns, keys or the 
manipulation of ATMs.

3D Printing regulation
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3D Printing trends and 
developments
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• Multi-material 3D printing
• Multi-color 3D printing
• Faster, better, larger and easier to use 3D printers
• Easier 3D modelling
• New applications for 3D printing 
• Improvements in metal printing
• 3D printed buildings
• New 3D printing materials

3D Printing trends and developments
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Examples
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Multi-material/multi-color 3D printing

Applications: highly realistic 
prototypes, models and 
learning aids; dissolvable 
supports

Available materials: resins, 
dissolvable filament
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Metal 3D printing

Applications: prototypes, 
functional parts, jewelry, 
medical implants, etc.

Available materials: 
aluminum, steel, brass, 
copper, silver, gold, platinum, 
titanium
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3D printed buildings

Applications: houses, 
apartments, office buildings, 
structures on Moon and Mars

Materials: concrete, plastic, 
resin, mud, etc.
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Large 3D prints - cars


